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Restore PostgreSQL

Restore workflow

The restore and recovery workflow includes planning, performing the restore operations,

and monitoring the operations.

The following workflow shows the sequence in which you must perform the restore operation:

You can also use PowerShell cmdlets manually or in scripts to perform backup, restore, and clone operations.

The SnapCenter cmdlet help and the cmdlet reference information contain detailed information about

PowerShell cmdlets.

SnapCenter Software Cmdlet Reference Guide.

Restore and recover a manually added resource backup

You can use SnapCenter to restore and recover data from one or more backups.

Before you begin

• You must have backed up the resource or resource groups.

• You must have canceled any backup operation that is currently in progress for the resource or resource

group that you want to restore.

• For pre restore, post restore, mount, and unmount commands, you should check if the commands exist in

the command list available on the plug-in host from the following paths:

For Windows: C:\Program Files\NetApp\SnapCenter\Snapcenter Plug-in

Creator\etc\allowed_commands.config

For Linux: /var/opt/snapcenter/scc/allowed_commands.config

If the commands do not exist in the command list, then the operation will fail.

About this task

• For ONTAP 9.12.1 and below version, the clones created from the SnapLock Vault Snapshots as part of

restore will inherit the SnapLock Vault expiry time. Storage admin should manually cleanup the clones post

the SnapLock expiry time.
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Steps

1. In the left navigation pane, click Resources, and then select the appropriate plug-in from the list.

2. In the Resources page, filter resources from the View drop-down list based on resource type.

The resources are displayed along with type, host, associated resource groups and policies, and status.

Although a backup might be for a resource group, when you restore, you must select the

individual resources you want to restore.

If the resource is not protected, “Not protected” is displayed in the Overall Status column. This can mean

either that the resource is not protected, or that the resource was backed up by a different user.

3. Select the resource, or select a resource group and then select a resource in that group.

The resource topology page is displayed.

4. From the Manage Copies view, select Backups either from the primary or secondary (mirrored or vaulted)

storage systems.

5.
In the Primary backup(s) table, select the backup that you want to restore from, and then click .

6. In the Restore Scope page, select Complete Resource.

a. If you select Complete Resource, all of the configured data volumes of the PostgreSQL cluster are

restored.

If the resource contains volumes or qtrees, the Snapshots taken after the Snapshot selected for restore

on such volumes or qtrees are deleted and cannot be recovered. Also, if any other resource is hosted

on same volumes or qtrees, then that resource is also deleted.

You can select multiple LUNs.

If you select All, all the files on the volumes, qtrees, or LUNs are restored.

7. In the Pre ops page, enter pre restore and unmount commands to run before performing a restore job.

Unmount commands are not available for auto discovered resources.

8. In the Post ops page, enter mount and post restore commands to run after performing a restore job.

Mount commands are not available for auto discovered resources.
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For pre and post commands for quiesce, Snapshot, and unquiesce operations, you should

check if the commands exist in the command list available on the plug-in host from the

/opt/snapcenter/snapenter/scc/allowed_commands.config path for Linux and C:\Program

Files\NetApp\SnapCenter\Snapcenter Plug-in Creator\etc\allowed_commands.config for

Windows.

9. In the Notification page, from the Email preference drop-down list, select the scenarios in which you want

to send the emails.

You must also specify the sender and receiver email addresses and the subject of the email. SMTP must

also be configured on the Settings > Global Settings page.

10. Review the summary, and then click Finish.

11. Monitor the operation progress by clicking Monitor > Jobs.

Restore and recover an auto discovered cluster backup

You can use SnapCenter to restore and recover data from one or more backups.

Before you begin

• You must have backed up the resource or resource groups.

• You must have canceled any backup operation that is currently in progress for the resource or resource

group that you want to restore.

• For pre restore, post restore, mount, and unmount commands, you should check if the commands exist in

the command list available on the plug-in host from the following paths:

For Windows: C:\Program Files\NetApp\SnapCenter\Snapcenter Plug-in

Creator\etc\allowed_commands.config

For Linux: /var/opt/snapcenter/scc/allowed_commands.config

If the commands do not exist in the command list, then the operation will fail.

About this task

• File-based backup copies cannot be restored from SnapCenter.

• For Auto-discovered resources, restore is supported with SFSR.

• Auto-recovery is not supported.

• For ONTAP 9.12.1 and below version, the clones created from the SnapLock Vault snapshots as part of

restore will inherit the SnapLock Vault expiry time. Storage admin should manually cleanup the clones post

the SnapLock expiry time.

Steps

1. In the left navigation pane, click Resources, and then select the appropriate plug-in from the list.

2. In the Resources page, filter resources from the View drop-down list based on resource type.

The resources are displayed along with type, host, associated resource groups and policies, and status.
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Although a backup might be for a resource group, when you restore, you must select the

individual resources you want to restore.

If the resource is not protected, “Not protected” is displayed in the Overall Status column. This can mean

either that the resource is not protected, or that the resource was backed up by a different user.

3. Select the resource, or select a resource group and then select a resource in that group.

The resource topology page is displayed.

4. From the Manage Copies view, select Backups either from the primary or secondary (mirrored or vaulted)

storage systems.

5.
In the Primary backup(s) table, select the backup that you want to restore from, and then click .

6. In the Restore Scope page, select Complete Resource to restore the configured data volumes of the

PostgreSQL cluster.

7. In the Recovery scope page, select one of the following options:

If you… Do this…

Want to recover as close as possible to the current

time

Select Recover to most recent state. For single

container resources specify one or more log and

catalog backup locations.

Want to recover to the specified point in time Select Recover to point in time.

a. Enter date and time. Enter date and time. For

example, the PostgreSQL Linux host is located

in Sunnyvale, CA and the user in Raleigh, NC is

recovering the logs in to SnapCenter.

If the user wants to perform a recovery to 5 a.m

.Sunnyvale, CA, then the user has to set the

browser time zone to the PostgreSQL Linux

host time zone, which is GMT-07:00 and specify

the date and time as 5:00 a.m.

Do not want to recover Select No recovery.

You cannot recover manually added PostgreSQL resources.
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SnapCenter Plug-in for PostgreSQL creates a backup_label and tablespace_map in

/<OS_temp_folder>/postgresql_sc_recovery<Restore_JobId>/_ folder to help recover manually.

1. In the Pre ops page, enter pre restore and unmount commands to run before performing a restore job.

Unmount commands are not available for auto discovered resources.

2. In the Post ops page, enter mount and post restore commands to run after performing a restore job.

Mount commands are not available for auto discovered resources.

For pre and post commands for quiesce, snapshot, and unquiesce operations, you should

check if the commands exist in the command list available on the plug-in host from the

/opt/snapcenter/snapenter/scc/allowed_commands.config path for Linux and C:\Program

Files\NetApp\SnapCenter\Snapcenter Plug-in Creator\etc\allowed_commands.config for

Windows.

3. In the Notification page, from the Email preference drop-down list, select the scenarios in which you want

to send the emails.

You must also specify the sender and receiver email addresses and the subject of the email. SMTP must

also be configured on the Settings > Global Settings page.

4. Review the summary, and then click Finish.

5. Monitor the operation progress by clicking Monitor > Jobs.

Restore PostgreSQL cluster using PowerShell cmdlets

Restoring a PostgreSQL backup includes initiating a connection session with the

SnapCenter Server, listing the backups and retrieving backup information, and restoring a

backup.

Before you begin

You must have prepared the PowerShell environment to execute the PowerShell cmdlets.

Steps

1. Initiate a connection session with the SnapCenter Server for a specified user by using the Open-

SmConnection cmdlet.

PS C:\> Open-SmConnection

2. Identify the backup that you want to restore by using the Get-SmBackup and Get-SmBackupReport

cmdlets.

This example shows that there are two backups available for the restore:
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 PS C:\> Get-SmBackup

        BackupId    BackupName                    BackupTime

BackupType

        --------    ----------                    ----------

----------

         1          Payroll Dataset_vise-f6_08... 8/4/2015 11:02:32 AM

Full Backup

         2          Payroll Dataset_vise-f6_08... 8/4/2015 11:23:17 AM

This example displays detailed information about the backup from January 29th 2015 to February 3rd,

2015:

PS C:\> Get-SmBackupReport -FromDateTime "1/29/2015" -ToDateTime

"2/3/2015"

SmBackupId           : 113

   SmJobId              : 2032

   StartDateTime        : 2/2/2015 6:57:03 AM

   EndDateTime          : 2/2/2015 6:57:11 AM

   Duration             : 00:00:07.3060000

   CreatedDateTime      : 2/2/2015 6:57:23 AM

   Status               : Completed

   ProtectionGroupName  : Clone

   SmProtectionGroupId  : 34

   PolicyName           : Vault

   SmPolicyId           : 18

   BackupName           : Clone_SCSPR0019366001_02-02-2015_06.57.08

   VerificationStatus   : NotVerified

   SmBackupId           : 114

   SmJobId              : 2183

   StartDateTime        : 2/2/2015 1:02:41 PM

   EndDateTime          : 2/2/2015 1:02:38 PM

   Duration             : -00:00:03.2300000

   CreatedDateTime      : 2/2/2015 1:02:53 PM

   Status               : Completed

   ProtectionGroupName  : Clone

   SmProtectionGroupId  : 34

   PolicyName           : Vault

   SmPolicyId           : 18

   BackupName           : Clone_SCSPR0019366001_02-02-2015_13.02.45

   VerificationStatus   : NotVerified
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3. Restore data from the backup by using the Restore-SmBackup cmdlet.

AppObjectId is "Host\Plugin\UID", where UID = <instance_name> is for manually discovered

PostgreSQL instance resource and UID = <instance_name>\<databse_name> is for

PostgreSQL cluster resource. You can get the ResourceID from the Get-smResources

cmdlet.

Get-smResources  -HostName cn24.sccore.test.com  -PluginCode PostgreSQL

This example shows how to restore the cluster from the primary storage:

Restore-SmBackup -PluginCode PostgreSQL -AppObjectId

cn24.sccore.test.com\PostgreSQL\PostgreSQLinst1\DB01 -BackupId 3

This example shows how to restore the cluster from the secondary storage:

Restore-SmBackup -PluginCode 'PostgreSQL' -AppObjectId

cn24.sccore.test.com\DB2\db2inst1\DB01 -BackupId 399 -Confirm:$false

-Archive @( @{"Primary"="<Primary

Vserver>:<PrimaryVolume>";"Secondary"="<Secondary

Vserver>:<SecondaryVolume>"})

The information regarding the parameters that can be used with the cmdlet and their descriptions can be

obtained by running Get-Help command_name. Alternatively, you can also refer to the SnapCenter

Software Cmdlet Reference Guide.

Restore resources using PowerShell cmdlets

Restoring a resource backup includes initiating a connection session with the SnapCenter

Server, listing the backups and retrieving backup information, and restoring a backup.

You must have prepared the PowerShell environment to execute the PowerShell cmdlets.

Steps

1. Initiate a connection session with the SnapCenter Server for a specified user by using the Open-

SmConnection cmdlet.

PS C:\> Open-Smconnection

2. Retrieve the information about the one or more backups that you want to restore by using the Get-

SmBackup and Get-SmBackupReport cmdlets.

This example displays information about all available backups:
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PS C:\> Get-SmBackup

BackupId                      BackupName                    BackupTime

BackupType

--------                      ----------                    ----------

----------

  1               Payroll Dataset_vise-f6_08... 8/4/2015    11:02:32 AM

Full Backup

  2               Payroll Dataset_vise-f6_08... 8/4/2015    11:23:17 AM

This example displays detailed information about the backup from January 29th 2015 to February 3rd,

2015:

PS C:\> Get-SmBackupReport -FromDateTime "1/29/2015" -ToDateTime

"2/3/2015"

   SmBackupId           : 113

   SmJobId              : 2032

   StartDateTime        : 2/2/2015 6:57:03 AM

   EndDateTime          : 2/2/2015 6:57:11 AM

   Duration             : 00:00:07.3060000

   CreatedDateTime      : 2/2/2015 6:57:23 AM

   Status               : Completed

   ProtectionGroupName  : Clone

   SmProtectionGroupId  : 34

   PolicyName           : Vault

   SmPolicyId           : 18

   BackupName           : Clone_SCSPR0019366001_02-02-2015_06.57.08

   VerificationStatus   : NotVerified

   SmBackupId           : 114

   SmJobId              : 2183

   StartDateTime        : 2/2/2015 1:02:41 PM

   EndDateTime          : 2/2/2015 1:02:38 PM

   Duration             : -00:00:03.2300000

   CreatedDateTime      : 2/2/2015 1:02:53 PM

   Status               : Completed

   ProtectionGroupName  : Clone

   SmProtectionGroupId  : 34

   PolicyName           : Vault

   SmPolicyId           : 18

   BackupName           : Clone_SCSPR0019366001_02-02-2015_13.02.45

   VerificationStatus   : NotVerified
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3. Restore data from the backup by using the Restore-SmBackup cmdlet.

Restore-SmBackup -PluginCode 'DummyPlugin' -AppObjectId

'scc54.sccore.test.com\DummyPlugin\NTP\DB1' -BackupId 269

-Confirm:$false

output:

Name                : Restore

'scc54.sccore.test.com\DummyPlugin\NTP\DB1'

Id                  : 2368

StartTime           : 10/4/2016 11:22:02 PM

EndTime             :

IsCancellable       : False

IsRestartable       : False

IsCompleted         : False

IsVisible           : True

IsScheduled         : False

PercentageCompleted : 0

Description         :

Status              : Queued

Owner               :

Error               :

Priority            : None

Tasks               : {}

ParentJobID         : 0

EventId             : 0

JobTypeId           :

ApisJobKey          :

ObjectId            : 0

PluginCode          : NONE

PluginName          :

The information regarding the parameters that can be used with the cmdlet and their descriptions can be

obtained by running Get-Help command_name. Alternatively, you can also refer to the SnapCenter Software

Cmdlet Reference Guide.

Monitor PostgreSQL restore operations

You can monitor the progress of different SnapCenter restore operations by using the

Jobs page. You might want to check the progress of an operation to determine when it is

complete or if there is an issue.

About this task

Post-restore states describe the conditions of the resource after a restore operation and any further restore

actions that you can take.

The following icons appear on the Jobs page, and indicate the state of the operation:
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•
 In progress

•  Completed successfully

•  Failed

•
 Completed with warnings or could not start due to warnings

•  Queued

•  Canceled

Steps

1. In the left navigation pane, click Monitor.

2. In the Monitor page, click Jobs.

3. In the Jobs page, perform the following steps:

a. Click  to filter the list so that only restore operations are listed.

b. Specify the start and end dates.

c. From the Type drop-down list, select Restore.

d. From the Status drop-down list, select the restore status.

e. Click Apply to view the operations that have been completed successfully.

4. Select the restore job, and then click Details to view the job details.

5. In the Job Details page, click View logs.

The View logs button displays the detailed logs for the selected operation.
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